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TurboCAD Pro V19.2 - Roll Top Computer Desk 
 

2D Concept to Blueprint Presentation 
 

Donald B. Cheke 
 
 
 
 
 
 

Tutorial is in Metric 

 
       

Some parts of this tutorial will seem familiar to anyone who has worked through the V11.2 & 
V15.1 versions of the Modern Desk tutorial. This tutorial, however, has been fully updated and 
expanded upon for use with TurboCAD Pro V19 and includes a roll top desk component. 
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form without written permission from the author. The purchaser may, however, print one copy of the 
document to paper and may make one backup copy of the downloaded material for personal safe 
keeping. 
 
Limitation of Liability 
 
While every effort has been taken in the preparation and the writing of this document the author 
assumes no responsibility for errors and/or omissions nor for the uses of the material and the decisions 
based on such use. No warranties are made, express or implied with regard to either the contents of the 
document, its merchant ability or fitness for a particular purpose. The author should not be liable for 
direct, indirect, special, incidental or consequential damages arising out of the use or inability to use the 
contents of this document. 
 
Special Note 
 
All of the work presented within this tutorial is based on TurboCAD Pro V19.2. Although users of previous 
versions are welcome to try the tutorial it cannot be stated what results will be achieved. Many changes, 
some subtle and others not so subtle, are made with each program revision. Although many steps and 
directions would be generic some may not be. The same can be said for tools between versions. Older 
versions may not have the same tools as Pro V19.2 and if the same tools are available the tools 
themselves may have been revised and hence, work in a different manner than they previously did. 
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Introduction 
 
Many requests have been made of the author to create a tutorial that would lead a woodworker through 
all the stages of a modern furniture design project. It was hoped that the tutorial would show how to use 
the program in such a way that a two-dimensional design concept could be turned into a three 
dimensional model for client presentation and that shop drawings could be created from the 2D and 3D 
drawings. This tutorial is the result of those requests. 
 
Construction note - the following design will be based on the use of 19 mm wood panels for construction  
and the cabinet components will be assembled, for the most part, using plate joinery biscuits. 
 
Within the tutorial, the reader will learn how to create all the 2D and 3D components required to create 
the modern roll top desk and accompanying drawings that are illustrated on the cover of the tutorial. 
Aside from learning how to draw in TurboCAD, the user will learn how to set up the drawing and how to 
insert standard lighting. The reader will learn how to establish render scene luminance and a render 
scene environment. The reader will also learn how to render their drawing and save it in a high resolution 
image format. The reader will also learn how to utilize paper space with inserted viewports and drafting 
palette objects, along with dimensions and annotations, plus much more. 
 
This tutorial is in no way intended to teach the fundamentals of furniture design or construction but 
rather it is intended to teach the use of some of the tools that TurboCAD has to offer and to introduce the 
new user to a drawing methodology. The author feels confident that the techniques outlined within the 
tutorial can help lay the foundation for future successful TurboCAD drawing and illustration for even the 
newest user. 
 
As with any technically advanced software, the user is generally faced with a steep learning curve. It is 
the hope of the author that the money and time spent working through a Textual Creations tutorial will 
help ease the learning and allow the reader to come away feeling confident that they made a wise 
decision. 
 
This tutorial will assume that the reader has the Platinum Edition of TurboCAD Pro 19.2 (64-Bit) with its 
extra architectural and mechanical tools, although no Platinum specific tools are used that the author is 
aware of. 
 
There are many ways to approach a project and it is likely that each person using the program would 
proceed in very different ways, so be open to alternative methods as experience builds. What is 
important is that the user becomes familiar with the objects that they wish to model and begin to look at 
them in a different way than they might otherwise do. What primitive shapes make up the whole? What 
will be required of these primitive shapes early in the drawing and how will this affect needs further 
along? What component or components should be started with? Many questions can only be answered 
through experience, but hopefully some of them will be answered by the time the beginner has worked 
through this tutorial. There is a great deal covered in this tutorial and the author urges the beginner to be 
patient, to read very carefully and to take the time necessary to do a good job. Try to enjoy the process as 
much as you will enjoy the final results. 
 
This tutorial assumes that the beginner has studied the desktop to some degree and can locate most of 
the tools. Since there are endless desktop configurations that can be set up in TurboCAD the author has 
opted to illustrate the required tools with the TurboCAD Classic user interface with its Office 2003 theme 
and the default toolbars in their undocked format. 
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Please remember that any supplied images and files are for use within the tutorial only and may not be 
shared or sold to others. 
 
Place all tutorial images in a permanent location on the hard drive. 
 
For those working through the tutorial in pre-V18 versions please note that most of the functions 
described in the tutorial, as being on the Modify menu, were on the Format menu in previous versions of 
the program. 
 
Also note that render times are much better in V18 & V19 than one will see if using previous versions of 
TurboCAD. TurboCAD now uses Multi-Threading for renders and can make use of multiple processors. 
The author has a fairly new Acer with 6 processers and has enable 5 for rendering. This is looked at as 
part of the set up further along. 
 
Lastly, the Copy in Place tool has finally been reintroduced into TurboCAD as a permanent tool. Users 
who don't have this new tool will need to use the Make Copy method. That is to select the object to copy 
in place, select the Make Copy tool to turn it on, tab into the first field on the Inspector Bar – but don't 
change anything – and simply press Enter. Select the Make Copy tool again to turn it off. 
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2D Drawer / Pedestal Design 
 
Imagine having a hanging legal size file folder and designing a whole desk around it. Does this sound a 
bit crazy? Although this may seem strange that is exactly what will be done within this tutorial and given 
the knowledge that folders are generally based on standard sizes the idea becomes less of an oddity. 
Although standardization exists in many cases a bit of research should be in order before any design is 
sent off to the shop for real world construction. In this design, the folders will hang on the sides of the 
drawer as opposed to metal rails, which would be an option to use by simply increasing the width of the 
drawers by about 1 inch. 
 
A two dimensional representation of the file, the drawers and the pedestal components will now be 
created to ensure that the folders will fit within the completed 3D pedestal unit. The second pedestal will 
be based on the first and although it will look the same, it will be modified to accommodate a computer 
tower. 
 
A set of hanging file folders similar to the ones in the image below were purchased at Staples Business 
Depot by the author and these folders will be the basis for the desk drawer and pedestal design. 
 

 
 
Switch to Front view. 
 

 
 
Select Plane by Active View from the Workplane toolbar. Note how the grid moved with the workplane. 
The grid is a good indicator of where the workplane is at any one time. 
 

 
 

Folder image from the Staples online catalogue 
 
 
Profiles being worked towards in this section. 
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Press Esc to deselect the selection. 
 
The results so far. 
 

 
 
The lap drawer profiles will now be created. The main desk has two similar pedestals and the space 
between them for this design is 712 mm. (The author considered making this space 762 mm to 
accommodate a large keyboard and mouse with pad but decided against it to keep the overall desk 
width down a bit. This is something a user should consider in the overall design scheme.) 
 
Select the Rectangle tool from the Line toolbar. 
 
Select Forest Green from the color dropdown menu on the Property toolbar. 
 

 
 
V SEKE snap the first point of the rectangle to the top right corner of the right side profile. Move the 
cursor in a right downwardly direction for a short distance and then Tab into the Inspector Bar and enter 
712 in the Size A field and 19 in the Size B field. Press Enter. 
 

 
 
A temporary placement rectangle is needed to mark where the lower stringer will be located. The desk 
design requires that a 600 mm space be left between the floor and the bottom of the lower stringer of 
the lap drawer. (For a real world build, check to see that this amount of knee space will work for you – it 
does for the author. If not, a designer could adjust accordingly.) 
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V SEKE snap the first point of a new rectangle to the bottom right corner of the right side profile. Move 
the cursor a in a right upwardly direction for a short distance and then Tab into the Inspector Bar and 
enter 100 in the Size A field and 600 in the Size B field. Press Enter. 
 

 
 
Press the Space Bar to exit the tool. 
 
Select the top stringer profile. Press D SEKE and relocate (V SEKE) the reference point to the lower left 
corner as indicated in the picture below. 
 

 
 
Right mouse click and select Rubber Stamp from the local menu. 
 
V SEKE snap a copy to the top left corner of the 100 × 600 mm placement rectangle. In progress below. 
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Select the left vertical rectangle. 
 
Select the Mirror Copy tool from the Copy toolbar. 
 
M SEKE snap the top line of the upper horizontal rectangle to define the first point on the mirroring line. 
Press and hold the Shift key down. Move the cursor downward a short distance and then left mouse click 
to define the second point of the mirroring line. Release the Shift key. In progress below. 
 

 
 
Select the top horizontal rectangle. Tab into the Inspector Bar and enter 330 in the Size X field. Press 
Enter. The top and sides will be miter cut, hence the overlap for now. 
 

 
 
Press Esc to deselect the selection. 
 
Press Ctrl + K to open the Select by Colors dialogue. Select Sky Blue and click OK. 
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Open the Properties dialogue for the selection. Under the Brush tab assign a Solid brush pattern and 95% 
Transparency. Click OK. 
 

 
 
Press Esc to deselect the selection. 
 

 
 
Turn off all layers, except layer 0. 
 

 
 
Create two new layers, one called Desk Top Profiles and one called Caddy Profiles.  
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Press the Space Bar to exit the tool. 
 
Select the 8 mm insert panel. Tab into the Inspector Bar and enter 710 in the Size X field, 6 in the Size Z 
field and -6 in the Delta Z field. Press Enter to make it a bit narrower, the correct thickness and to drop it 
back down into the groove. 
 

    
 
Press Esc to deselect the selection. 
 

 
 
A notch is required at the top of the insert panel to allow wires to travel to the mouse and keyboard. A 
user also needs a way to get the insert panel in and out and the author considered a couple finger holes 
or perhaps two small pulls or tabs that could be placed at the lower end for the user to lift the panel and 
pull out to access the hidden wire area. Finger holes will be used and they will be created now along with 
the notch. 
 
Switch to Front view. 
 
Select Plane by Active View from the Workplane toolbar. 
 
Select the Rectangle tool from the Line toolbar. 
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Select Red from the color dropdown menu on the Property toolbar. 
 

 
 
M SEKE snap the 19 mm line segment of the outer polyline with arcs, as indicated in the picture below, 
to place the first point of the rectangle. 
 

 
 
Move the cursor in a left downwardly direction for a short distance and then Tab into the Inspector Bar 
and enter 19 in Size A and Size B fields. Press Enter. 
 

 
 
Switch to Isometric SW view. 
 
Select the Simple Extrude tool from the 3D Object toolbar. 
 
Select the Use Compound Profile option. 
 
Select the forest green polyline, as indicated in the picture below, as the entity to extrude. 
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Move the cursor to the right and left mouse click when the extrusion is past the side panel upright to 
define the extent of the extrusion. 
 

 
 
Select the forest green polyline, as indicated in the picture below, as the next entity to extrude. 
 

 

www.textualcreations.ca


Donald B. Cheke                                                                                                                                                                                                       www.textualcreations.ca 

 154

Create a new layer called Closed Tambour. 
 

 
 
Turn off the new layer. 
 
Select the tambour and assign it to the Closed Tambour layer. In progress below. 
 

 
 
Turn on the Opened Tambour Profiles layer. 
 
Select the Simple Extrude tool from the 3D Object toolbar. 
 
Press and hold the Shift key down. Starting with the rectangle, select all the pale green tambour profiles. 
Release the Shift key. 
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Switch to Isometric NE view. 
 
Select the 3D Polyline tool from the 3D Object toolbar. 
 
Orbit a bit as needed and using two M SEKE snaps place a vertical line on the back of the pull, as 
indicated in the picture below. Select Finish after the second snap. 
 

 
 
Press the Space Bar to exit the tool. 
 
Select all 2D and 3D components of the pull. In progress below. 
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Switch to Isometric SE view. 
 
Press Esc to deselect the selection. 
 

 
 
Turn off all layers, except layer 0 and then turn on the layers as indicated in the picture below. 
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The results so far. 
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Select the Wireframe icon from the Render toolbar to end the render. 
 
Select the box with the material applied. Tab into the Inspector Bar and enter .1 in the Scale X, Y and Z 
fields. Press Enter. This will be the seed. 
 

 
 
Press Ctrl + A to select all visible components in the drawing. 
 
Open the Materials palette. Locate the Wood Wraps category and double click the RT Desk A thumbnail 
to apply the material to the selection. 
 

 
 
Select the Quality Rendering icon on the Render toolbar to render the selection. 
 
Press Esc to deselect the selection. 
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It looks like only the back panels need reorientation. 
 

 
 
Select the Wireframe icon from the Render toolbar to end the render. 
 
Select the seed. 
 
Select the Copy in Place tool one time. 
 
Tab into the Inspector Bar and enter 90 in the X Rotation field and 270 in the Z Rotation field. Press 
Enter. 
 

 
 
Right mouse click and select Rubber Stamp from the local menu. Move the cursor to the upper edge of 
each back panel, one at a time, and E SEKE snap a copy in place. In progress below. 
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Saving the Second Rendered Image 
 
This render will now be saved. 
 
With the desired view now fully rendered on screen select Save As from the File menu at the top of the 
TurboCAD desktop. 
 
Under the Save As dialogue, select the desired Save in location from the dropdown menu at the top of 
the dialogue. 
 
Select JPG – TurboCAD for Windows JPEG from the Save as type dropdown menu. 
 
Enter the file name Roll Top Desk Tutorial Closed.jpg. Select Save. 
 
If need be, click okay at the format 'not supported' warning. (Seems to be gone in V18 & v19.) 
 
Allow time for the render to save. (25 seconds on the author's off the shelf Acer). 
 
Minimize TurboCAD for a moment. 
 
Open the saved render and note the crispness of the saved image. 
 

 
 
Close the image and maximize TurboCAD. 
 
Select the Wireframe tool from the Render toolbar two times, once to end the render and once to turn off 
perspective. 
 
Turn off the Closed Tambour and Closed Tambour Pulls layers. 
 
Turn off the Ground Plane layer. 
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Page 1 - General Overview 
 
Select the Insert Viewport tool from the Named View toolbar. 
 

 
 
Using two G SEKE snaps place a viewport roughly the same size and at the location indicated in the 
picture below. In progress below. Always place viewport with upper left placement first, followed by lower 
right placement. 
 

 
 
Select Left View from the Named View dialogue that opens. Click Go to. Click Close. 
 

   
 
Select the Insert Viewport tool from the Named View toolbar. 
 
Using two G SEKE snaps place another viewport roughly the same size and at the location as indicated in 
the picture below. In progress below. 
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Press Esc to move out of the Inspector Bar. 
 
Select the top view viewport. Press D SEKE and relocate (M SEKE) the reference point to a lap stringer. 
 

 
 
Tab into the Inspector Bar and paste (Ctrl + V) the copied number into the X Position field. Press Enter. 
 

 177.8000059075 mm 
 

 
 
Press Esc to deselect the selection. 
 
Double click the Isometric viewport to open the Properties dialogue. 
 
Check Hidden Line. 
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Press the Space Bar to exit the tool. 
 
The right panel of the right pedestal has unique holes so a copy of the far left viewport will be moved 
upward and the appropriate layers turned off or on. 
 
Select the far left viewport. 
 

 
 
Select the Copy in Place tool one time. 
 
Tab into the Inspector Bar and enter 80 in the Delta Y field. Press Enter. 
 

 
 
Double click the selected viewport to open the Properties dialogue. 
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Page 4 - Drawers Sheet 1 
 
Select Paper 2. 
 

 
 
Right mouse click on the Paper 2 tab and select Duplicate from the local menu. 
 

 
 
A duplicate is placed at the end (Paper 4). Select Paper 4. 
 

 
 
Double click on the Title to open the Properties dialogue. Under the General tab replace Overall 
Dimensions with Drawers - Sheet 1. Click OK. 
 

 
 
Double click on SHEET 2 of 8 to open the Properties. Change the 2 to a 4 and click OK. 
 

 
 
Double click on SCALE 1:15 to open the Properties. Change the last 5 to a 0 and click OK. 
 

 
 
Select and delete all the dimensions. 
 
Double click on the left viewport to open the Properties dialogue. Under the Viewport tab, in the Layer 
Name window, uncheck everything except Layer 0, Lower Drawer Case, Middle Drawer Case and Upper 
Drawer Case. Select a Fixed scale of 1:10.  
 

   
 
Under the Hidden Line tab, select Set custom hidden line style. Click OK. 
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